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1 Overview 

The Getting Started Manual covers installing and upgrading the TrueAllele® 

Casework software, and provides information about network and backup systems.  

The basics of starting the program, connecting to a database, and a glossary of 

common terms are also available in this manual. 

 

1.1 DNA Interpretation Process 

 

 
Figure 1. DNA Interpretation Process 

 

The DNA interpretation process can be broken down into two transformations 

(Figure 1).  The goal of each transformation is to preserve as much identification 

information as possible.  In the first step, a laboratory transforms the biological 

evidence samples into DNA signals.  The second transformation involves the 

interpretation of the DNA signals into genotypes.  The TrueAllele Casework software 

handles this step by quantitatively interpreting DNA signals using probabilistic 

genotype modeling.  Mathematical formulas communicate the genotypes as 

identification information.   
 

1.2 Background Information  

There is a wealth of material available from Cybergenetics for learning about the 

objective computer interpretation of quantitative DNA evidence.  Here is a guide to 
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getting started.  The essential information is provided in these manuals.  Additional 

publications and presentations are available on the Cybergenetics website. 

 

Newsletters 
The best place to begin is with Cybergenetics DNA Investigator™ newsletters, 

located at http://www.cybgen.com/information/newsletters.shtml.  These short 

articles are written for the nonscientist.  These newsletters introduce TrueAllele 

Casework and show the system’s use in court, different validation studies, and 

comparisons with human review.  

 

Publications 
An introduction to a DNA match is found in this short expository article, located at 

http://www.cybgen.com/go/ISHI2010.  

 

The operation and significance of the TrueAllele system are described in this peer-

reviewed, scientific validation paper located at http://www.cybgen.com/go/JFS2011.  

It is recommended to read this long article over three separate sessions:  

 

1. Introduction, Materials and Methods.  These sections teach the underlying prin-

ciples of probabilistic genotyping and DNA identification information.  They also 

explain how to rigorously assess the reliability of any DNA interpretation method.  

 

2. Case Example.  A DNA mixture from a real case was analyzed both by man and 

machine.  The computer's match score was a billion times greater.  Ten different 

reasons, explored at ten different genetic loci, are examined to explain how com-

puters can preserve the match information that humans discard.  

 

3. Results and Discussion.  Computer and human review that were conducted on 

the same sixteen DNA mixture casework items are compared.  The results the 

TrueAllele computer’s reliability and show that the computer is typically a million 
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times more informative than human.  The computer simply makes better use of 

the DNA data.  

 

Course Lectures 
Course material (videos, slides, transcripts, etc.) is provided about quantitative DNA 

mixture interpretation, located at 

http://www.cybgen.com/information/courses/page.shtml.  The six 20 minute lectures 

on "DNA Identification for Scientists: Basics & Methods" are the starting point for 

students desiring a real understanding of scientific DNA interpretation.  

 
Additional References 
After this basic introduction, there are scientific presentations about TrueAllele's 

methods and results available for review, located at 

http://www.cybgen.com/information/presentations/page.shtml.  These short narrated 

PowerPoint movies provide a living history of the TrueAllele technology and its 

applications as presented at scientific meetings. 

 

Cybergenetics researchers have written many scientific publications about 

TrueAllele evidence interpretation and how it fully preserves DNA identification 

information, located at http://www.cybgen.com/information/publication/page.shtml.   
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2 Hardware Requirements 

The minimum system requirements for the VUIer™ software are: 

 

OS: Windows XP or Mac OS X 10.6 or higher 

CPU: Pentium 4 processor 

RAM: 1024 MB RAM 

Storage: 1GB of free hard drive space 

Display: Screen resolution of 1024x768 (higher resolutions recommended) 
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3 Software Installation 

This chapter walks through the TrueAllele Casework installation for a Macintosh 

computer.  A complete TrueAllele Casework installation package includes the MCR 

Engine, the Analyze Module of the VUIer software, and the VUIer software itself.  

Optionally, the VUIer documentation can also be installed.  Cybergenetics supplies 

each part of the package for the complete installation of all parts.  Installation 

instructions for a PC are found in the Appendix  PC Installation. 

 

3.1 MCR Engine 

The MCR Engine is an underlying program that powers the graphics and statistical 

calculations of the VUIer software.  The MCR engine is never independently started 

when operating the VUIer software, but the program must be preinstalled for proper 

operation. 

 

A user begins by expanding the zip file “MCR_Engine.pkg.zip”, which makes the 

package file “MCR_Engine_Installer_v716.pkg” available.  The user then double 

clicks on the package file to begin the installation process. 
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On the introduction screen (Figure 2), selecting ‘Continue’ advances to the next 

screen. 

 

 
Figure 2. Introduction Screen. 

 

Next, the user must select a destination to install the software in the Destination 

Select window (Figure 3).  Most likely, this will be for all users of the computer. 

 

 
Figure 3. Destination Select Screen 
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In the Installation Type window (Figure 4), the user selects ‘Install’ to begin the 

installation process.  When prompted, the administrator user name and password is 

entered. 

 

 
Figure 4. Standard Install. 

 

Once installation is complete, selecting ‘Close’ exits the installer (Figure 5).  

 

 
Figure 5. Installation complete. 
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3.2 Analyze 

The Analyze Module transforms the raw sequencer files into quality checked peak 

data for upload to the TrueAllele Server.  Installing the Analyze Module installs the 

program itself and creates the user environment.  If Analysis is already installed on a 

Viewstation, the user should remove this application and corresponding ‘trueallele’ 

folder before upgrading the program, saving any customized files elsewhere, if 

necessary.  

 

Program Installation 
The user starts by expanding on the zip file “Analyze.pkg.zip”, which makes the 

package file “Analysis.pkg” available.  The user then double clicks on the package 

file to begin the installation process. 

 

On the introduction screen (Figure 6), selecting ‘Continue’ advances to the next 

screen. 

 

 
Figure 6. Introduction Screen. 
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The next screen contains a Read Me file for review (Figure 7).  After reading the file, 

the user selects ‘Continue’ to advance to the next screen. 

 

 
Figure 7. Read Me. 

 

Next is the license agreement (Figure 8).  After selecting ‘Continue’, a prompt 

appears to confirm agreement with the license.  The user proceeds by selecting 

‘Agree’. 

 

 
Figure 8. License Agreement. 
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If prompted, the user selects a destination to install the software in the Destination 

Select window (Figure 9).  Most likely this will be for all users of the computer. 

 

 
Figure 9. Destination Select Screen. 

 

A standard install is automatically available.  The user begins installation by 

selecting ‘Install’ (Figure 10).  When prompted, the administrator user name and 

password is entered. 

 

 
Figure 10. Standard Install. 
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After the installation is complete, selecting ‘Close’ finishes the process (Figure 11). 

 

 
Figure 11. Installation complete. 

 

This completes the installation of the Analyze Module, and data can now be 

processed in the Analyze Module.  

 

User Environment 
The user environment includes all necessary templates and settings for processing 

the data in Analyze and is contained in a ‘trueallele’ folder.  After installation, the 

‘trueallele’ folder appears in the Documents folder of the user account.  For 

example, if a user is logged in as ‘DNA’, the ‘trueallele’ folder will be created in 

DNA’s documents folder.  
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3.3 VUIer 

The VUIer software allows the user to upload and ask questions of the case data 

and then review and report the answers produced by the genetic calculator.   

 

The user starts by expanding the zip file “VUIer.pkg.zip”, which makes the package 

file “VUIer.pkg” available.  The user then double clicks on the package file to begin 

installation. 

 

On the introduction screen (Figure 12), selecting ‘Continue’ advances to the next 

screen. 

 

 
Figure 12. Introduction Screen. 
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The next screen contains a Read Me file for review (Figure 13).  After reading the 

file, the user selects ‘Continue’ to advance to the next screen. 

 

 
Figure 13. Read Me. 

 

Next is the license agreement (Figure 14).  After selecting ‘Continue’, a prompt 

appears to confirm agreement with the license.  The user proceeds by selecting 

‘Agree’. 

 

 
Figure 14. License Agreement. 
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If prompted, the user selects a destination to install the software in the Destination 

Select window (Figure 15).  Most likely this will be for all users of the computer. 

 

 
Figure 15. Destination Select Screen 

 

A standard install is automatically available.  The user begins the installation by 

selecting ‘Install’.  When prompted, the administrator user name and password is 

entered. 

 

A custom installation can be performed anytime that the VUIer software is installed 

on a computer.  In the Installation Type window, selecting ‘Customize’ brings up the 

Custom Install options (Figure 16).  The user is able to deselect any of the items that 

they do note wish to install when installing/upgrading VUIer.  This action will affect 

the installation of some required user files.   
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Figure 16. Custom Install. 

 

After the installation is complete, selecting ‘Close’ finishes the process (Figure 17).  

The VUIer software is now installed and available for use.   

 

 
Figure 17. Installation complete. 
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3.4 Update 

The same process is followed when updating the VUIer software as described in 

section 3.3.  However, the user can save any customized preference files (such as 

the report.txt file) elsewhere on the computer before updating VUIer.   

 

In the Installation Type window (Figure 18), the user selects ‘Install’.  When 

prompted, the administrator user name and password is entered. 

 

 
Figure 18. Standard Install. 

 

After the installation is complete, selecting ‘Close’ finishes the process.  The VUIer 

software is now updated and available for use.  The user can then replace any of the 

preference files with their customized ones. 
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3.5 Documentation 

If desired, the user can install the VUIer documentation to be accessed from the 

Help menu of any module in the VUIer software.  This documentation includes the 

Workflow manual, the Getting Started manual, the various module manuals, and a 

Tutorial manual as well as Database and Kinship application notes.  

 

The user starts by expanding the zip file “VUIer_Documentation.pkg.zip”, which 

makes the package file “VUIer_Documentation.pkg” available.  The user then double 

clicks on the package file to begin installation. 

 

On the introduction screen (Figure 19), selecting ‘Continue’ advances to the next 

screen. 

 

 
Figure 19. Introduction Screen. 
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The next screen contains a Read Me file for review (Figure 20).  After reading the 

file, the user selects ‘Continue’ to advance to the next screen. 

 

 
Figure 20. Read Me. 

 

Next is the license agreement (Figure 21).  After selecting ‘Continue’, a prompt 

appears to confirm agreement with the license.  The user proceeds by selecting 

‘Agree’. 

 

 
Figure 21. License Agreement. 
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If prompted, the user selects a destination to install the documentation in the 

Destination Select window (Figure 22).  The documentation can only be installed for 

the current user account. 

 

 
Figure 22. Destination Select Screen 

 

The user begins the installation by selecting ‘Install’ (Figure 23).  When prompted, 

the administrator user name and password is entered. 
 

 
Figure 23. Standard Install. 
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After the installation is complete, selecting ‘Close’ finishes the process (Figure 24).  

The VUIer documentation is now installed in the Documents/trueallele/docs folder 

and is available from the Help menu in the VUIer modules.  Note: the documentation 

will be opened with the default PDF reader on the computer.  A PDF reader must be 

installed in order to view the documentation.  Also, after an Analyze update, the 

documentation will need to be reinstalled. 

 

 
Figure 24. Installation complete. 
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4 Software Function 

Now the typical method of opening the VUIer program is reviewed.  An alternative 

method for starting the program is covered in the Appendix  Diagnostic Support.  
 

4.1 Starting the VUIer program 

The user starts the VUIer program by clicking on its icon (Figure 25) in the Dock on 

a Macintosh (typically located at the bottom of the screen) or from the Desktop 

shortcut or Programs Files folder on a PC.  On some computers, the Dock may 

automatically hide, but placing the mouse cursor at the bottom of the screen will 

make it appear. 

 

 
Figure 25. VUIer icon. 

 

If the VUIer icon is not already in the Dock, it can be placed there in a few simple 

steps.  First, the user selects the Finder icon (Figure 26) in the dock.  

 

 
Figure 26. Finder icon. 
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This selection opens the Finder window, displaying the computer’s folders and files.  

From the left side bar, the user selects Applications.  In the Applications folder, the 

user locates the VUIer icon, then clicks and drags the icon down to the Dock.  This 

will place VUIer in the Dock.  

 

4.2 Connecting to a Database 

In the VUIer program, the Connect window allows a user to connect to a database or 

to switch to a different database at any time during the TrueAllele process. The user 

can open the Connect window by selecting the Database  Connect menu option in 

any VUIer Module.  

 

Connect window 
To connect, a user selects the desired database from the dropdown menu (this 

action fills in the System field as well).  The user then enters a username and 

password under the Authenticate heading and clicks ‘Verify’.  A blue check mark is 

present when the connection is verified.  The Connect window (Figure 27) will 

automatically close when the connection is verified indicating that the process is 

complete. 

 
Figure 27. The Connect window. 
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Clearing Information  
To clear all of the information entered in the Connect window fields, the user can 

use the ‘Clear’ button at the bottom right of the window.  When finished with this 

process, the ‘Close’ button will close the window. 

 

Connection Difficulties 
If a red “X” appears with the message “Database Connection Failure” when clicking 

the ‘Verify” button instead of the blue check or the window closing, the connection to 

the database was not successful.  

 

This message could mean that incorrect user account information was entered.  The 

user name and password are case sensitive, so the user should first check that the 

information was entered correctly. 

 

4.3 Closing the VUIer Program 

The TrueAllele Server accepts a limited number of concurrent user connections.  A 

user must properly end user sessions so the connection is open for another user.  

There are two main methods of ending a user session. 

 

When finished using the VUIer software, the user can close the program by 

selecting App  Quit.  This will close the program and automatically log out of any 

current connections. 

 

If a user does not want to close the VUIer program but wishes to end the current 

session, the user can logout of a TrueAllele World.  From within any module, 

selecting Database  Logout will log a user out of the current database, making the 

connection available for other users. 
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To close a window within a module, the user selects File  Close.  To close a 

module and go back to the module chooser, a user selects File  Exit Module.  This 

selection brings up a dialog box asking a user if they wish to exit the particular 

module and choose a different one.  Here a user selects “Yes” to exit or “Cancel” to 

remain in the current module.  
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5 Network Setup 

5.1 Adding Server to Client Network 

Before using TrueAllele, the server must be set up.  The following section addresses 

the steps to set up the server and network.  If additional help is needed, 

Cybergenetics should be contacted for support. 

 

To add the server to the network: 

 

Unpack server then locate network and power. 

• Plug Ethernet cord in Ethernet port #1. 
 

Log in with root password. 

• Type ‘startx’ to bring up the graphical user interface. 

• The Star icon  is the Network dialog and is found in the top menu bar or 
under the System  Administration  Network menu. 

• Select eth0 by double clicking it from the dialog that opens (Figure 28). 

• Type IP address, subnet mask and gateway (if necessary) into Ethernet 
Device dialog that opens. Click OK after all information is entered. 
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Figure 28. The Ethernet Device dialog. 

 
Next, the Network Configuration window opens.  Select eth0 from the list and click 

the Deactivate button to refresh network (Figure 29).  If prompted, save changes.  

Click the Activate button to bring the network back up with the new settings applied. 
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If you need to restart the network manually you can do so from the Terminal.  To 
restart the Network: In Terminal, type “service network restart” and then 

press Enter. 

 
In Terminal, type “ip addr” to check that the ip address is correct (under eth0 

entry, inet line) (Figure 30). 

 

Figure 29. The Network Configuration window. 
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You can confirm the server has been correctly setup from the TrueAllele 

ViewStation. 

 

5.2 Confirm the Network Connection 

The following section outlines the steps for confirming the network connection to the 

server. 

 
To confirm the network connection: 

 
Open the VUIer and select the Request Module. 

• In the menu bar, select Database  Connect. 
• Select ‘general use’ from the drop-down menu. 
• In the URL enter the server IP address. 
• Enter general TrueAllele World account information. 
• Press the Verify button. 
• Blue check means that the network is up and running. 

  If there is a red X, the VUIer is unable to reach the server. 

Figure 30. The results of ip addr. 
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5.3 Update the Connect File 

After the server is running, the connect file can be edited in order to have the 

software auto-complete the connection information. 

 

To update the connect file: 

 

Connect File:  

• Open the Tools module. 

• From the Tools menu select ‘VUIer Preferences’. 

• From the drop-down menu in the dialog select Connect. 

• Edit the connect file by replacing (insert server IP) with the server’s IP ad-

dress. 

• Save the file as text. 
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6 Backup Setup 

6.1 Overview 

The TrueAllele Server performs automated daily backups of each of the TrueAllele 

Worlds on the server.  These backup files contain a complete copy of all requests 

and data that are present on that World. 

 

The backup files are stored on the server in the /backup/download directory.  This 

folder is accessible via the root account and can be copied to other media to provide 

off-machine backup. 

 

6.2 Copying to Physical Media 

The following section outlines the steps to backup the server onto physical media. 

Physical media includes CDs, external hard drives, etc.  

 

Note: This assumes that the system has not yet been logged in and the process is 

starting from the log in window. 

 

To save backups to physical media: 

 

At the login prompt, log in as the root user.  Once you are logged in as root, type 

‘startx’ to start the GUI. 

 

To navigate to the /backup directory, select the Computer icon on the desktop.  This 

will open a Linux file explorer window.  Select Filesystem to open a window showing 



 

 

TrueAllele VUIer Getting Started  Cybergenetics ©  2014 Page 33 of 54 

 

the top-level / directory.  Select backup to enter the backup directory and see the 

/download directory.  The /download directory contains all of the backup files. 

 

When you insert optical media (DVD or CD), a new icon will appear on the desktop 

called Blank DVD+R Disc.  (The exact name will vary based on the media used). 

Simply click and drag the /download directory to the media.  Select the media icon to 

open a CD/DVD Creator.  All files that will be burned to the media will be displayed 

in this window.  Select the ‘Write to Disc’ button in the top right to begin the writing 

process. 

 

For external hard drives or thumb drives, simply plug the drive into the server.  A 

new icon for the hard drive will appear on the desktop.  You can simply drag the 

/download directory to that icon to move files to the hard drive. 

 

6.3 Copying Files via the Network 

To aid the transfer of files between the server and another computer, an FTP client 

can be used.  Cybergenetics recommends using WinSCP for Windows or 

Cyberduck for Macintosh.  These programs provide a visual interface for moving 

files over a network via SFTP.  The steps to perform this task are outlined in the 

following section. 

 

Note: The following instructions are for using Cyberduck on a Mac ViewStation.  The 

steps for using WinSCP on a PC are similar. 

 

To transfer files between the server and another computer: 

 

Start Cyberduck, and select the Open Connection button in the menu bar (Figure 

31).  This will open a New Connection dialog. 
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Figure 31. The Open Connection icon. 

 

Fill out the New Connection dialog with the following parameters (Figure 32):  

 

Username: root 

Password: root password (this information is specific to the server) 

Server: server IP address (this information is specific to the server) 

File protocol: SFTP  

Port number: 22 

 

 
Figure 32. The New Connection dialog. 

 

After establishing a secure FTP connection, you will be presented with a file explorer 

interface.  This interface will let you drag files and folders to the remote computer. 

 

Select the directory drop-down from the menu bar and select the top-level directory 

/.  The main finder window (Figure 33) will now display all the directories under the 

top-level including /backup.  Select /backup, and you will see the /download directo-
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ry.  Simply drag and drop the /download directory onto the Mac Desktop to begin 

copying the complete backup information. 

 

 
Figure 33. The main Finder window displaying /. 

 

Once the files have finished moving, you can store the backup on other media.  The 

iMac ViewStation supports burning to a DVD or moving the files to an external hard 

drive. 
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7 Appendix 

This appendix is designed to provide specific information that may help in TrueAllele 

processing.  A glossary of common terms is also provided. 

 

7.1 PC Installation 

The steps for installing the MCR Engine, Analysis Module, and VUIer software on 

both a 32-bit and 64-bit Windows PC are found in this Appendix.  The user should 

note that before updating any of the programs, the customized user directories and 

preferences can be saved elsewhere on the computer in order to preserve and 

reinstate them after an update. 

 

MCR Engine 
A user begins by expanding the zip file “MCR_Engine_64bit.exe.zip” (or 

“MCR_Engine_32bit.exe.zip”), which makes the executable file 

“MCR_Engine_64bit.exe” (or “MCR_Engine_32bit.exe “) available.  The user then 

double clicks on the execute file to begin the installation process. 
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On the introduction screen (Figure 34), selecting ‘Next’ advances to the next screen. 

 

 
Figure 34. Introduction Screen. 

 

Next, the user must select a destination folder in which to install the software in the 

Folder Selection screen (Figure 35).  

 

 
Figure 35. Folder Selection Screen. 
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After selecting a destination to install the software, the user must confirm the 

creation of the destination folder by selecting ‘Yes’ (Figure 36). 

 

 
Figure 36. Folder Selection Confirmation. 

 

In the Confirmation window (Figure 37), the user selects ‘Install’ to begin the 

installation process.  If prompted, the administrator user name and password is 

entered. 

 

 
Figure 37. Confirmation Window. 
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Once installation is complete, selecting ‘Finish’ exits the installer (Figure 38). 

 

 
Figure 38. Installation Complete Screen. 

 
 
Analyze 
To install the Analyze module on a PC (either 32-bit or 64-bit), expanding on the zip 

file “Analyze_64bit.exe.zip” (or “Analyze_64bit.exe.zip”), which makes the 

executable file “Analyze_64bit.exe” (or “Analyze_32bit.exe”) available.  The user 

then double clicks on the execute file to begin the installation process. 
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On the introduction screen (Figure 39), selecting ‘Continue’ advances to the next 

screen. 

 

 
Figure 39. Introduction Screen. 

 

The next screen contains a license agreement for review (Figure 40).  After reading 

and accepting the agreement, the user selects ‘Next’ to advance to the next screen. 

 

 
Figure 40. License Agreement. 
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Next is the customer information screen (Figure 41).  After entering the appropriate 

information and selecting the user(s) to install the application for, the user selects 

‘Next’ to proceed. 
 

 
Figure 41. Customer Information Screen. 

 
On the next screen, the user chooses the default setup type and clicks ‘Next’ to 

continue (Figure 42). 
 

 
Figure 42. Setup Type Window. 
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On the ready to install screen (Figure 43), the user selects Install to begin the 

Analyze installation.  If prompted, the administrator user name and password is 

entered. 

 

 
Figure 43. Ready to Install. 

 
After the installation is complete, selecting ‘Finish’ completes the process (Figure 

44).  This completes the installation of the Analyze Module, and data can now be 

processed in the Analyze Module.  

 

 
Figure 44. Installation Complete. 
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If necessary, the user should copy the ‘trueallele’ folder to every user’s ‘My 

Documents’ directory and add or replace any custom user directories or templates to 

this ‘trueallele’ folder. 

 
Updating Analyze 

Before updating Analyze, the user should first copy any customized files to be kept 

from the C:\Documents and Settings/username/My Documents/trueallele/system 

folder.  Then, the user should uninstall any older versions of Analysis by using the 

Add or Remove Programs feature.  After removing the software, the user should 

delete the C:\Documents and Settings/username/My Documents/trueallele directory 

for every user.  Then, Analysis can be updated following the same steps outlined 

previously.  

 

 

VUIer 
The user starts by expanding the zip file “VUIer_64bit.exe.zip” (or 

“VUIer_32bit.exe.zip”), which makes the package file “VUIer_64bit.exe” (or 

“VUIer_32bit.exe”) available.  The user then double clicks on the executable file to 

begin installation. 
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On the introduction screen (Figure 45), selecting ‘Next’ advances to the next screen. 

 

 
Figure 45. Introduction Screen. 

 

The next screen contains a license agreement for review (Figure 46).  After reading 

and accepting the agreement, the user selects ‘Next’ to advance to the next screen. 

  

 
Figure 46. License Agreement. 
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Next is the customer information screen (Figure 47).  After entering the appropriate 

information and selecting the user(s) to install the application for, the user selects 

‘Next’ to proceed. 

 

 
Figure 47. Customer Information Screen. 

 
On the next screen, the user chooses the default setup type and clicks ‘Next’ to 

continue (Figure 48). 

 

 
Figure 48. Setup Type Window. 
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On the ready to install screen (Figure 49), the user selects Install to begin the VUIer 

installation.  If prompted, the administrator user name and password is entered. 

 

 
Figure 49. Ready to Install. 

 

After the installation is complete, selecting ‘Finish’ completes the process (Figure 

50).  The VUIer software is now installed and available for use.   

 

 
Figure 50. Installation Complete. 
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For updating VUIer, the same steps are followed.  However, the user can save any 

customized preference files before updating in order to preserve the customizations.  

The user is then able to create a VUIer shortcut on the Desktop by right-clicking the 

program file and selecting Send to   Desktop (create shortcut).  
 

 

Documentation 
The user starts by expanding the zip file “VUIer_Documentation.exe.zip”, which 

makes the package file “VUIer_Documentation.exe” available.  The user then double 

clicks on the executable file to begin installation. 

 

On the introduction screen (Figure 51), selecting ‘Next’ advances to the next screen. 

 

 
Figure 51. Introduction Screen. 
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The next screen contains a license agreement for review (Figure 52).  After reading 

and accepting the agreement, the user selects ‘Next’ to advance to the next screen. 

  

 
Figure 52. License Agreement. 

 

Next is the customer information screen (Figure 53).  After entering the appropriate 

information and selecting the user(s) to install the application for, the user selects 

‘Next’ to proceed. 

 

 
Figure 53. Customer Information Screen. 
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On the next screen, the user chooses the default setup type and clicks ‘Next’ to 

continue (Figure 54). 
 

 
Figure 54. Setup Type Window. 

 
On the ready to install screen (Figure 55), the user selects Install to begin the VUIer 

documentation installation.  If prompted, the administrator user name and password 

is entered. 

 

 
Figure 55. Ready to Install. 
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After the installation is complete, selecting ‘Finish’ completes the process (Figure 

56).  The VUIer documentation is now installed and available from the Help menu in 

the VUIer modules.  Note: the documentation will be opened with the default PDF 

reader on the computer.  A PDF reader must be installed in order to view the 

documentation.  Also, after an Analyze update, the documentation will need to be 

reinstalled. 

   

 
Figure 56. Installation Complete. 

 

7.2 Spinning Wait Cursor 

Spinning Wait Cursor 

 

The spinning wait cursor is equivalent to the hourglass icon on a PC.  This icon 

indicates that TrueAllele is retrieving data from the database.  This cursor is only 

active when it is held over a VUIer window.  If the mouse is moved off of the window 

(for example, to the desktop), the cursor will go back to the normal pointer. 

 



 

 

TrueAllele VUIer Getting Started  Cybergenetics ©  2014 Page 51 of 54 

 

7.3 View Menu 

In several modules of the VUIer program, there is a View Menu.  This menu allows 

the user to change sizing options for modules that have more than one interface 

window open at a time.  The View Menu includes options for automatically sizing 

and positioning the interfaces as well as making the interface text larger and smaller.  

There are also toolbar buttons that allow the user to position the interface windows 

on the screen (Figure 57), where the white portion of the icon indicates where the 

window will be positioned.  In addition, keyboard shortcuts exist for making interface 

text larger (⌘=) and smaller (⌘–) (ctrl= and ctrl– on a PC). 

 

 
Figure 57. View Icons. These icons position the active interface window to the position on the screen 

denoted by the white part of the square. 
 
 

7.4 Diagnostic Support 

To aid in diagnostic support of the VUIer program, an alternate means of starting the 

program is available.  This method is not routinely used but is available to aid in 

support calls to Cybergenetics. 

 

First, the user opens a Terminal window by selecting the Terminal icon (Figure 58) 

from the Dock. 

 

 
Figure 58. Terminal icon. 
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A blank Terminal window opens (Figure 59), displaying the computer’s name and a 

command prompt. 

 

 
Figure 59. A blank Terminal window. 

 

In the Terminal window, the user copy and pastes the path: 
/Applications/VUIer.app/Contents/MacOS/run_VUIer.sh  

And then hits the enter key (Figure 60). 

 

 
Figure 60. A Terminal window with the path filled in. 
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By starting the VUIer program this way, diagnostic messages that are displayed 

during software operation appear in the Terminal window.  These messages can be 

copied and pasted into an email to Cybergenetics if support is required. 

 

7.5 Glossary 

This glossary presents some commonly used terms.  The term of interest is 

italicized. 

 

Evidence data comprise STR experiments on a set of samples.    

 

An observed genotype is a probability distribution over a set of possible allele pairs 

at a locus.  

 

The identification hypothesis is that a suspect contributed their DNA to an evidence 

sample.   

 

Identification information is the logarithm of the identification LR.   

 

A likelihood function determines the fit between data and model.  (More formally, it is 

the probability of the data given a model.)   

 

An identification likelihood ratio (LR) is the weight of evidence in favor of an 

identification hypothesis.  The LR can be calculated as a ratio of two match 

probabilities.   

 

A Markov chain is a visual history of the search that the system performs in order to 

find the best-fit model for the data.  

 

A match occurs when two genotypes are equal.   
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A match probability is the probability of a genotype match.  

 

A mixture is a DNA sample that contains two or more individual contributors.   

 

A probability model is a mathematical formulation that accounts for observed data.   

 

A validation study assesses the efficacy and reproducibility of an interpretation 

method for extracting identification information from DNA data.  


